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READ ME FIRST 

 

 

 

 

 

 

 

 

  

1 

4 

In case you're not familiar with the terminology, 
Read Me First is quite often the name given to a 
computer file that contains important information 
for people to know prior to using an application. 

This section contains some important information to 
help you use this book so we thought we'd start 
with a Read Me First section. 

 

What skills and knowledge 
you will acquire... 

The skills and knowledge acquired in Microsoft Access 2016 - Simple 
Queries are sufficient to be able to use and operate the software 
effectively. 

What you'll need to know 
before beginning this 
course... 

Microsoft Access 2016 - Simple Queries assumes little or no knowledge 
of the software. However, it would be beneficial to have a general 
understanding of personal computers and the Windows operating system 
environment. 

 

The objectives of this guide… At the completion of this course you should be able to: 

create simple and effective queries 

perform more advanced queries using a variety of querying 
techniques 

create queries based on one or more tables 

create meaningful reports from tables 

What you get in a chapter... Each chapter begins with a summary page listing the topics covered in 
that chapter. The chapter then consists of single-page topic sheets 
pertaining to the theme of the chapter. 

What you'll need to have 
before commencing this 
course... 

Many of the topics in this learning guide require you to open an existing 
file with data in it. These files can be obtained from your instructor and 

need the product code for this course which is AccessSimpleQueries. 

As you work through this 
guide… 

It is strongly recommended that you close all open files, if any, prior to 
commencing each new chapter in this learning guide. Each chapter, 
where relevant, has its own set of exercise files and any from a previous 
chapter are no longer required.  

Where to from here... Have a look at the next page which explains how a topic page works, 
ensure that you have access to the exercise files (see above), and you're 
ready to make a start. 
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The majority of this book comprises single-page 
topic sheets. There are two types of topic sheets: 
task and reference. The layout of both is similar 
– an overview at the top, detail in the centre and 

additional reference (optional) material at the 
bottom. Task sheets contain a Try This Yourself 
step-by-step exercise panel in the detail area as 
shown below. 

 
Topic name 

 
General topic overview provides an introduction to the topic 

 
Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice 
exercise for you to work through. In Reference topic sheets this is usually replaced 
by a box with reference information. 

 
In Task topic sheets screen shots and graphics provide a visual clue as to what 
will happen when you work through the Try This Yourself practice exercise. In 
Reference topic sheets the screen shots and graphics are used to visually 
represent information and concepts. 

 
The For Your Reference (optional) element provides a quick summary of the steps 
required to perform a task. These usually only appear in Task-based topic sheets. 

 
The Handy To Know (optional) element provides additional information such as 
alternate ways of accomplishing a task or further information providing handy tips.  

 

1 

2 

3 

4 

5 6 

WORKING WITH TOPIC SHEETS 
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CHAPTER 1 CREATING QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of how queries work 

 learn how to create a new query design 

 learn how to work with a query 

 learn how to modify a query design 

 learn how to apply record criteria for a query 

 learn how to clear selection criteria 

 learn how to save a query 

 learn how to run queries from the Navigation pane 

 learn how to delete a query from a database file 

 gain an understanding of creating additional queries. 

You can easily sort and locate data using table sorting and filtering 
options. However, these are relatively lightweight when compared 
to using queries. 

Queries are sometimes known as Query By Example, or QBE. A 
query is like a report based on the data in a table. With a query you 
are required to specify which fields to see in the query, and which 
records to display. 

This is done by giving Access criteria to search for, much the same 
as what is done for a simple filter. For example, listing all of the 
records that have Sales in the Department field, or all of the 
records that occurred on 12/3/2016, are examples of queries. 

Once the criteria and output fields are nominated, Access will 
search through the data and produce a table of matching records. 

INFOCUS 
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UNDERSTANDING QUERIES 
 

 

 

 

 

   

A select query is like a filter that you place on 
your data so that you see only the information 
that is relevant to you. Select queries can be 
used, for example, to produce a list of customers 

from Tasmania, or all of the items that you've 
purchased in the last six months valued at $300 or 
more. Select queries are so named because they 
select records according to your query design. 

Select queries are created 
using the Create tab of the 
ribbon, and are run and 
modified as a Query object 
in the Navigation pane. 

Select queries are based on 
a Query Design. The upper 
part of the design is known 
as the Field List, while the 
lower portion is known as the 

Query Grid. 

The records displayed in the 
query are determined by the 
sample data that you enter 
into the Criteria row in the 
Query Grid – this is why the 
process is sometimes 
referred to as query by 
example. 

The easiest way to see the 
data is to switch to 
Datasheet view. In 
Datasheet view the data that 
matches the query criteria is 
displayed in a special 
dynaset table. A dynaset is 
a subset of the full table of 
data – however, it is still a 
live set of data and any 
changes made to data here 
will be reflected back in the 
full table later on. 

Field list 

Query grid 

Criteria row 
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CREATING A QUERY DESIGN 
 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Queries are created from the Create tab on the 
ribbon. Like table structures, there is a design 
view where the layout, criteria, and the like, 
required for the query are specified, and a run 

view where the data is brought into the design 
layout structure from the relevant table. The first 
step in creating a query, therefore, is to create a 
query design structure. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file Creating 
Queries_1.accdb… 

 
Click on the Create tab, 
then click on Query 
Design in the Queries 
group to display a new 
query design and the 
Show Table dialog box 

 
Click on [Add] to add the 
Employees table fields to 
the design, then click on 
[Close] to close the dialog 
box 

 
In the field listing 
double-click on EmpNo, 
LastName, FirstName 
and Department to add 
these fields to the grid in 
this order 

 
Click on Save in the QAT 
to display the Save As 
dialog box 

 
Type qryEmployees in 
Query Name, then click 
on [OK] 

The name of the query will 
now appear in the 
Navigation pane under the 
Queries header… 

 
Close the query 

 

1 

2 

For Your Reference… 

To create a query design: 

1. Click on the Create tab 

2. Click on Query Design in the Queries group 

3. Add the table and select the fields 

4. Save the query 

3 

Handy to Know… 

 The Show Table dialog box, displayed when 
creating a new query design, lists all of the 
tables and queries in the current database 
file. 

Double-click on the entries here to add them to the 
table below 
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WORKING WITH A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries offer you the ability to see snapshots of 
your data – a particular view or representation of 
your data at a point in time. There are three main 
views within a query: the design view where you 

specify what data you wish to see in the snapshot; 
the datasheet view where the data based on the 
design is displayed; and SQL view which shows 
the programming behind the query. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Creating 
Queries_2.accdb... 

 
Double-click on 
qryEmployees to see 
the query in Datasheet 
view, displaying the data 

 
On the Home tab, click 
on the top half of View 
in the Views group to 
toggle between Design 
and Datasheet views 

 
Click on the bottom half 
of View to display a 
menu of options 

 
Select SQL View to see 
the SQL code required 
behind the scenes to 
create the query 

 
Close the query 

 

1 

For Your Reference… 

To see different aspects of a query: 

1. Double-click on the query to see it in 
Datasheet view 

2. On the Home tab, click on the top half of 
View in the Views group to toggle between 
Design and Datasheet views 

3 

Handy to Know… 

 Until you seriously get into programming, you 
won't use the SQL View option for queries all 
that often. SQL is pronounced "sequel" or 
simply S.Q.L. 

4 
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CHANGING A QUERY DESIGN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Most query designs are not as critical as table 
designs and can therefore be changed randomly 
and when the need arises. Select queries, 
where you are trying to extract matching data, 

are often run using a trial and error approach where 
the query design is experimented with and modified 
until the perfect solution is found.  

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Queries_3.accdb... 

 
In the Navigation pane, 
right-click on 
qryEmployees to display a 
menu of options, then select 
Design View to see the 
query in Design view 

 
Scroll down the list of fields 
in the Employee field listing 
and double-click on 
WeeklyHours and then 
Salary to place both fields 
at the end of the grid 

 
Click on WeeklyHours in 
the grid then, on the Query 
Tools: Design tab, click on 
Insert Columns in the 
Query Setup group 

A new, blank column will 
appear… 

 
Click on the drop arrow in 
the new column and select 
Started 

 
Click on the Home tab, then 
click on the top half of View 
in the Views group to run 
the query and see the data 
presented in the modified 
design 

 
Click on Save in the QAT, 
then close the query 

 

2 

4 

For Your Reference… 

To insert more fields into a Design grid: 

 Double-click on the field name in the field 
listing, or 

 Click in the grid, then click on Insert 

Columns in the Query Setup group 

Handy to Know… 

 You can delete a field from a query grid by 
clicking on it and then clicking on Delete 
Columns in the Query Setup group on the 
Home tab. 

5 
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APPLYING RECORD CRITERIA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

The real power of a query lies in its ability to 
display a filtered list of records in a dynaset. To 
filter the records and see only the ones that you 
want, you will need to enter search criteria in the 

criteria row in the query grid. You simply type an 
example of the data that you want to see in the 
criteria cell and run the query to display all records 
from the original table that match the criteria. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Queries_4.accdb... 

 
Right-click on 
qryEmployees to display a 
menu of options and select 
Design View 

 
Click in the Criteria cell for 
Department and type 
Administration 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to see only those 
records with 
Administration in the 
Department field 

 
Repeat step 3 to switch 
back to Design view 

 
Type 40 in the Criteria cell 
for WeeklyHours, then click 
on View to display only 
those people who work 40 
hours in the 
Administration department 

 
Switch to Design view and 
type >=80000 in the 
Criteria cell for Salary, then 
click on View to see all 
Administration people who 
work 40 hours and earn 
$80,000 or more 

 
Save and close the query 

2 

3 

For Your Reference… 

To select records in a query: 

1. Click in the Criteria cell for a field and type 
the desired search criteria 

2. On the Query Tools:Design tab, click on 
View in the Views group to run the query 

Handy to Know… 

 When creating queries, if you add more 
criteria across fields, you are creating what is 
known as an AND query – you want records 
that have this AND this AND this... 

 When constructing queries, use > for greater 

than and < for less than situations. 

6 
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CLEARING SELECTION CRITERIA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You do need to exercise a little care when 
running queries. If you leave residual criteria from 
an earlier query in the query grid (which is easy 
to do if you have more fields than can be seen on 

the screen), you may end up with incorrect results. 
It is a good idea therefore to clear the selection 
criteria after you have performed a query and found 
the data that you want. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Creating 
Queries_5.accdb... 

 
In the Navigation pane, 
right-click on 
qryEmployees to display a 
menu of options and select 
Design View 

 
Point to the left of the first 
criteria cell until the mouse 
pointer changes to a black 
horizontal arrow  

 
Click once to select the 
entire criteria row 

 
Press  to delete all of 
the criteria in the row 

 
Save and close the query 

 

2 

For Your Reference… 

To clear selection criteria: 

1. Point to the left of the row and click once to 
select it 

2. Press  to delete the criteria in the row 

3 

Handy to Know… 

 When working with a query design, you can 
delete the contents of a single cell in the 
Criteria row by double-clicking on the value 

in the cell and pressing . 

4 
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SAVING A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are two main types of select queries: those 
that you create as a one-off search of the data; 
and those that you create for repeated and 
on-going use. If you are going to use a query on 

a regular basis it should be saved. You can then 
also use it as a template to create other queries 
with variations perhaps to the criteria or the field 
grid. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Queries_6.accdb... 

 
Right-click on qryEmployees 
to display a menu of options 
and select Design View 

 
Type Administration in the 
Criteria cell for Department 

 
On the Query Tools: Design 
tab, click on View in the Views 
group to see the results – 
there should be 26 records 

 
Click on the File tab, then click 
on Save As to display the 
Save As area 

 
Click on Save Object As in 
File Types, then click on 
[Save As] to display the Save 
As dialog box 

 
Type qryEmployeesAdmin 
and click on [OK] 

The new query appears in the 
Navigation bar… 

 
Switch to Design view then 
repeat steps 2 to 6 to create 
another query that only 
displays employees from the 
Executive department – save 
this query as 
qryEmployeesExec 

 
Close the query 

 

3 

5 

7 

For Your Reference… 

To save a query: 

1. Create the query 

2. On the File tab, click on Save As, then click 
on Save Object As and click on [Save As] 

3. Type a name and click on [OK] 

Handy to Know… 

 It is important to give your queries 
meaningful names so that you remember 
what they are for. Using a prefix, such as 
qry, will tell you at a glance that you are 
looking at a list of queries and make the 
queries easier to distinguish from tables, 
forms and reports. 
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RUNNING QUERIES FROM THE NAVIGATION PANE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                   , 

Queries store the layout, fields, criteria and other 
information required to produce the list of data 
that you want. Given that they can be time 
consuming to create, especially in the case of 

complex queries, it makes sense to save them and 
then run them as often as you require. Queries can 
be run directly from the object listing in the 
Navigation pane, as often as you like. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Creating 
Queries_7.accdb... 

 
In the Navigation pane 
under Queries, 
double-click on 
qryEmployees, then 
double-click on 
qryEmployeesAdmin, 
then double-click on 
qryEmployeesExec 

Notice how the names of 
the three queries appear 
in three separate tabs at 
the top of the window. 
The last query opened is 
the one that is currently 
seen and is known as the 
“active” query… 

 
Click on the tab for 
qryEmployeesAdmin to 
see the employees in the 
Administration 
department 

 
Click on the tab for 
qryEmployees to see all 
of the employees 

 
Close each query 

 

1 

2 

For Your Reference… 

To run a query from the Navigation pane: 

 In the Navigation pane, double-click on the 

name of the query from the Query object list 

Handy to Know… 

 Queries do not contain data. Each time a 
query is opened in Datasheet view, Access 
retrieves the latest data from the table upon 
which the query is based and uses the query 
design to display the relevant records and 
information. 

3 
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DELETING A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries often work with data that is stored in 
tables or that results from other queries. They 
can be used to create data by performing 
calculations and can be used as a source of data 

for other queries, forms and reports. Therefore, you 
should be especially careful when deleting queries 
– make sure that the query is not used by any other 
objects in the database first. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Creating 
Queries_7.accdb... 

 
Click on 
qryEmployeesExec in 
the Navigation pane 
to select it 

 
On the Home tab, click 
on Delete in the 
Records group 

A warning message 
will appear, seeking 
your confirmation to 
delete the query… 

 
Click on [Yes] to 
confirm the deletion 

The query no longer 
appears listed under 
Queries in the 
Navigation pane 

 

1 

2 

3 

For Your Reference… 

To delete a query from a database file: 

1. Click on the name of the query in the 
Navigation pane 

2. On the Home tab, click on Delete in the 
Records group 

Handy to Know… 

 You can delete a query by clicking on it in the 

Navigation pane and pressing . 
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CREATING ADDITIONAL QUERIES 
 

 

 

 

  

 

Select queries are by far the most common type 
of query that you will create and use. In this 
assignment you will have the opportunity to put 
your understanding of queries to use by creating 

a wide range of different queries, including those 
that show records that match specific criteria, and 
those that fit within specific ranges of dates. 
 

Sub Heading 

Use the qryEmployees query to run the various queries as shown. Note that you will have to clear the 
criteria from time to time. Also, we won’t need these queries so there is no need to save them. 

Save the final query design as qryEmployeesNew then close it. 

The datasheet that shows the results is exactly like a table and you can therefore use the Print 
commands on the File tab to print the result once the datasheet is displayed. 

Access automatically places quotation marks around criteria based on text. The quotation marks are 
programming symbols that tell the computer to treat the data as character strings rather than numbers. 
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NOTES: 
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CHAPTER 2 QUERYING TECHNIQUES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
INFOCUS 

Queries provide a very powerful way of extracting information from 
your table structures. But there is more to queries than just simple 
select statements. By using features such as expressions, 
operators, and sorting and moving fields within a query, there is 
virtually no limit to the information you can extract from a table.  

In this session you will: 

 learn how to change a saved query 

 learn how to create an AND query 

 learn how to create OR queries 

 learn how to query numeric data 

 learn how to query dates 

 learn how to use a range expression to extract records 
between values 

 learn how to query for opposite values 

 learn how to move fields in a query grid 

 learn how to sort the output of a query 

 learn how to remove fields from a query 

 learn how to use wildcards to query data 

 learn how to handle problem characters in queries 

 learn how to create a query using a transaction and a 
lookup table 

 learn how to sort data numerically 

 learn how to search for empty fields using a query 

 learn how to query for uniqueness. 
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MODIFYING A SAVED QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries can be run as a one off and then 
discarded when no longer needed, or they can be 
saved and run over and over again. Saved 
queries, however, are not set in stone and can 

easily be modified and adapted as your changing 
needs arise. Saved queries can also be used as 
templates for creating other queries. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file Query 
Techniques_1.accdb… 

 
In the Navigation pane, 
double-click on 
qryEmployees to run the 
query 

 
On the Home tab, click on 
the top half of View in the 
Views group to see the 
query in Design View 

 
Click on the checkbox in 
Show for FirstName until 
it appears without a tick, 
as shown 

 
Click on the top half of 
View to display the 
datasheet, this time 
without the FirstName 
field 

 
Click on Save to save the 
design changes 

 
Close the query 

 

1 

For Your Reference… 

To modify a saved query: 

1. Open the query in Design View 

2. Make changes as appropriate 

3. Click on Save 

Handy to Know… 

 Each time you run a query, a fresh set of 
data from the underlying table(s) is queried 
and extracted. When you make a change to 
a query you are changing its structure and 
design – not the data that it presents. 

4 

3 
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CREATING AND QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you create a simple query you place an 
example of what you want in the Criteria cell in 
the query grid. If you place criteria in several cells 
for different fields, you create an AND query. 

This means that for a record to be displayed it must 
satisfy all of the criteria, that is, it must satisfy the 
first criteria AND the second criteria AND any other 
criteria as specified. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Query 
Techniques_2.accdb... 

 
Right-click on qryEmployees 
and select Design View 

 
Click in the Criteria cell for 
Department and type 
Administration 

 
On the Query Tools: Design 
tab, click on the top half of 
View in the Views group to 
run the query – only 
Administration employees 
are shown (25 records) 

 
Click on the top half of View 
to return to Design View 

 
Click in the Criteria cell for 
Salary and type >70000 

 
Click on the top half of View 
to run the query – only 
Administration employees 
with a salary greater than 
$70,000 are now shown (10 
records) 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – AND Example 
in Save to, then click on [OK] 

 
Close the query 

 

2 

3 

For Your Reference… 

To create an AND query: 

1. Open the query in Design View 

2. Type multiple criteria in the same Criteria 
row for different fields 

Handy to Know… 

 If no records appear when you run a query, 
you should check the spelling of the criteria – 
Access will only find records in the table that 
exactly match what you have typed. 

 To create an AND query, there must be 
criteria in the same row in two or more 
Criteria cells. 

5 

6 

This query translates to “show all records that have Administration 
in Department AND have a Salary greater than 70000” 
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CREATING OR QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In normal language we use AND and OR 
interchangeably and make ourselves understood. 
In computers this ambiguity is not possible. For 
example, we might want Access to list all of the 

Administration records and to list all of the 
Executive records. What we really need to ask is to 
find all records that have Administration in 
Department OR Executive in Department. 

Try This Yourself: 

S
a

m
e

 

F
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Continue using the previous 
file with this exercise, or open 
the file Query 
Techniques_3.accdb... 

 
Right-click on qryEmployees 
and select Design View 

 
Click in the Criteria field for 
Department and type 
Executive 

 
On the Query Tools: Design 
tab, click on the top half of 
View in the Views group to 
run the query – only 
Executives are shown (6 
records) 

 
Click on View to return to 
Design View 

 
Click in the or field for 
Department and type 
Administration 

 
Click on View to run the 
query – only records with 
Executive OR Administration 
in Department are shown (32 
records) 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – OR Example 
in Save to, then click on [OK] 

 
Close the query 

 

2 

3 

For Your Reference… 

To create an OR query: 

1. Open the query in Design View 

2. Type the first value in the Criteria field 

3. Type subsequent values in the or fields 
below the Criteria field 

4. Run the query 

Handy to Know… 

 Rather than typing multiple values in the or 
fields below Criteria, you can use the OR 
operator to list multiple matches. To do this 
you would, for example, type "Executive" 
OR "Administration" (including the 
quotation marks) in the Criteria field for 
Department. 

5 

6 
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QUERYING NUMERIC DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
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F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_4.accdb... 

 
Open qryEmployees in 
Design View 

 
Click in the Criteria field for 
Salary and type 57000 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to show employees 
with a salary of exactly 
$57,000 

 
Click on View to return to 
Design View 

 
Click to the immediate left of 
57000, type < , then click on 
View to display all 
employees with a salary less 
than $57,000 

 
Repeat steps 4 and 5 with 
the criteria as shown 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on 
[Save As] 

 
Type Query – Numeric Data 
Example in Save to, then 
click on [OK] 

 
Close the query 

 

For Your Reference… 

To query numeric data: 

1. Open the query in Design View 

2. Type a numeric value in Criteria (if 
necessary, precede it with a logical operator 
such as >, <, >=, <=, or <>) 

3. Run the query 

When you select text, you are usually searching 
for whole words. When querying numeric data 
however, you generally search for values greater 
than or less than a specific number. For example, 

you might want all expenses over $20.00. Numbers 
can be searched using special logical operators 
which tell Access to look for values that are greater 
than, less than or equal to specific values. 

2 

3 

Handy to Know… 

 When constructing criteria in queries, 
numeric data does not have quotation marks 
around them (unlike text). 

 When constructing criteria in queries, the 
equal sign (=) always appears after the 
greater than (>) or less than sign (<), for 
example, >= or <=. 

Criteria Purpose Records 

>57000 list all salaries greater than $57,000 35 

>=57000 list all salaries greater than or equal to 
$57,000 

40 

<57000 list all salaries less than $57,000 60 

<=57000 list all salaries less than or equal to $57,000 65 

<>57000 list all salaries not equal to $57,000 95 

 

6 2 3 

5 
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QUERYING DATES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dates pose a problem in computer applications 
such as Access. Dates are normally typed using 
a slash (/) which is the same symbol used to 
denote the mathematical operation of division. So 

how does the computer differentiate between a 
formula and a date? In Access, this is done by 
enclosing dates in hash (#) signs. Dates can also 
be used with logical operators. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Query 
Techniques_5.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Criteria field for 
Started and type 02/12/10 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to show employees 
who started on December 
2, 2010 (16 records) 

 
Click on View to return to 
Design View 

Notice that the date is 
enclosed with # symbols… 

 
Repeat steps 2 to 4 for 
each of the values as 
shown 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Date 
Example in Save to and 
click on [OK] 

 
Close the query 

 

2 

3 

4 

For Your Reference… 

To search for dates using a query: 

1. Open the query in Design View 

2. Type a numeric value (if necessary, precede 
it with a logical operator such as >, <, >=, <=, 
or <>) 

3. Run the query 

Criteria Purpose Records 

>2/12/10 employees who started after December 
2, 2010 

40 

>=2/12/10 employees who started on or after 
December 2, 2010 

55 

<2/12/10 employees who started before December 
2, 2010 

45 

<=2/12/10 employees who started on or before 
December 2, 2010 

60 

<>2/12/10 employees who started on dates other 
than December 2, 2010 

85 

Handy to Know… 

 In query Criteria fields, Access will 
automatically put hash signs around dates 
for you. The signs will appear when you 
move off the Criteria field. 

 If your query dates are not working, check 
Windows to see if your computer is set up for 
American-style dates (mm/dd/yy). 

5 
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USING A RANGE EXPRESSION 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Suppose you want to display all employees who 
started between July and September, or all 
employees with salaries between 80,000 and 
100,000. In this type of query you are looking for 

records between a range of criteria. Ranges like 
this can be handled using a formula in the Criteria 
cell of a query – in Access these formulas are 
known as expressions. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_6.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Criteria field for 
Started and type >=19/7/10 
AND <=06/9/10 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to show employees 
who started between July 
and September, 2010 (15 
records) 

 
Click on the top half of View 
to return to Design View 

 
Click in the Criteria field for 
Salary and type >=80000 
AND <=100000 

 
Click on the top half of View 
– there should be 8 records 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on 
[Save As] 

 
Type Query – Range 
Expression Example, then 
click on [OK] 

 
Close the query 

 

2 

5 

For Your Reference… 

To create a range formula (expression): 

1. Open the query in Design View 

2. Type the first Criteria value using > or >=, 
type AND, then type the second value using 
< or <= 

3. Run the query 

The range expression in Step 5 pulls out only those employees 
who started between July and September, 2007 and who have 
salaries between $80,000 and $100,000. 

6 

Handy to Know… 

 There is a Between operator that you can 
use to create a range expression in a query. 
For example, you can type Between 100 
And 120 in the criteria field for (e.g.) 
Amount to display the range greater than 
100, but less than 120. 
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QUERYING OPPOSITE VALUES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Generally, select queries are used to list all of the 
records that match or conform to specific criteria. 
However, sometimes you may need to produce 
an exception listing where all records that do not 

meet the criteria are selected. This can be done in 
an Access query using the NOT operator. This 
operator is placed in the Criteria field in front of the 
sample data. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_7.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Criteria field for 
Department and type NOT 
Administration 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to show all employees 
who are not in the 
Administration department 
(74 records) 

 
Click on the top half of View 
to return to Design View 

 
Click at the end of Not 
“Administration” and type 
AND NOT Executive 

 
Click on the top half of View 
– there should be 68 records 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Opposite 
Values Example, then click 
on [OK] 

 
Close the query 

 

2 

5 

For Your Reference… 

To display opposite values: 

1. Open the query in Design View 

2. Type the Criteria value, but precede it with 
the keyword NOT 

3. Run the query 

Handy to Know… 

 A NOT expression can sometimes be an 
efficient substitute for a complex OR 
expression. Rather than specifying all of the 
things you want using OR, you can specify 
what you don’t want using NOT. 

The criteria in Step 5 display only employees that are not in the 
Administration department and are not in the Executive department 

6 
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MOVING FIELDS IN A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you first create a query, you will add the 
fields in the order that you think you will need 
them. However, you may find a situation where 
you want to reorganise the fields to create a 

slightly different report. Moving fields in a query grid 
is virtually the same as moving fields in a table – it 
is simply a matter of dragging and dropping the 
fields into their new positions. 

Try This Yourself: 

S
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m
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F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_8.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click slightly above the 
Department column header 
to select the column 

 
Drag the column header left, 
until a thick black vertical 
line appears to the left of 
EmpNo 

 
Release the mouse button 
to complete the move 

 
Repeat steps 2 to 4 to move 
the EmpNo field to the right 
of LastName 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to see how the moved 
columns appear 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Moving 
Fields Example in Save to, 
then click on [OK] 

 
Close the query 

 

3 

4 

For Your Reference… 

To move a field in the query grid: 

1. Open the query in Design View 

2. Click on the column header, then drag the 
header to a new location 

Handy to Know… 

 Once a query is run you can drag columns 
around in the Datasheet view of the query – 
remember, the Datasheet view of a query is 
like the Datasheet view of a table, and 
whatever you can do in a table, you can do in 
the query result. 

5 

6 
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SORTING QUERY DATA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As a default, the data in a query datasheet is 
sorted in the same order as the underlying table 
upon which the query is based. You can actually 
change this using the Sort option that appears in 

the query grid. The Sort option allows you to 
nominate which fields to sort the results on – you 
can also specify the sort order (ascending or 
descending). 

Try This Yourself: 

S
a

m
e

 F
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e
 Continue using the 

previous file with this 
exercise, or open the file 
Query 
Techniques_9.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Sort field for 
LastName to display the 
drop arrow 

 
Click on the drop arrow 
and select Ascending so 
that the LastName field 
will be sorted from A – Z 

 
On the Query Tools: 
Design tab, click on the 
top half of View in the 
Views group to see the 
results table sorted by 
LastName 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Sorting 
Example in Save to, then 
click on [OK] 

 
Close the query 

 

2 

3 

For Your Reference… 

To create a sorted query: 

1. Open the query in Design View 

2. Click in Sort for the field to sort by 

3. Click on the drop arrow and select either 
Ascending or Descending 

Handy to Know… 

 By default, sorting in a query grid is 
performed in the order of the fields in the 
grid. 

4 
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REMOVING FIELDS FROM A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries are often constructed using a process of 
trial and error. Since the structure of a query is 
largely determined by the underlying table of the 
query, not as much planning and thought needs 

to go into choosing the fields for a query. So you 
can add and remove fields as and when required. 
Removing a field from a query is done using the 
Delete Columns command. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_10.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Started field 
header in the query grid 

 
On the Query Tools: 
Design tab, click on Delete 
Columns in the Query 
Setup group to remove the 
selected field 

You can also remove 
several fields at once… 

 
Click on the grey bar directly 
above Department to select 
the field, then hold down 

 and click on the grey 
bar above Salary to select 
the three fields 

 
Repeat step 3 to delete the 
selected fields 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Deleted 
Fields Example in Save to, 
then click on [OK] 

 
Close the query 

 

2 

3 

For Your Reference… 

To delete fields from the query grid: 

1. Select the field(s) to delete 

2. On the Query Tools: Design tab, click on 

Delete Columns in the Query Setup group 

Handy to Know… 

 If you are unsure about deleting a field, 
remove the tick from the Show tick box of 
the field. This way, the field will still remain in 
the query grid, but will not appear when the 
query is run. 

4 

5 
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QUERYING USING WILDCARDS 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sometimes you don't know exactly what you are 
looking for or you may only want to match the 
first character or two. In these situations you can 
query using a wildcard. There are two wildcards: 

the asterisk (*) is used to replace any number of 
characters at the position of the asterisk; while the 
question mark (?) is used for any single character 
in the same position as the wildcard. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file Query 
Techniques_11.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Criteria field 
for LastName and type S* 

 
On the Query Tools: 
Design tab, click on the 
top half of View in the 
Views group to see all 
employees whose last 
name begins with S (6 
records) 

 
Click on the top half of 
View in the Views group, 
to return to Design View 

 
Try some alternatives in 
the Criteria field for 
LastName, as shown 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Wildcard 
Example in Save to, then 
click on [OK] 

 
Close the query 

 

2 

3 

Criteria Purpose Records 

Sa* list all employees whose last name begins 
with the letters Sa 

1 

*son list all employees whose last name ends 
with the letters son 

12 

“[CS]*” list all employees whose last name begins 
with either the letter C or S 

13 

S?m* list all employees whose last name begins 
with the letter S, contains anything as the 
second letter and has m as the third letter 

1 

 

5 

For Your Reference… 

To use a wildcard to search in a query: 

1. Open the query in Design View 

2. Type the Criteria using either the * wildcard 
to replace all subsequent characters, or the 
? wildcard to replace only the current letter 

3. Run the query 

Handy to Know… 

 When you use a wildcard in queries, Access 
uses the Like operator in the criteria. You will 
notice that the criteria is changed by Access 
to (e.g.) Like “Sa*”. You can of course type 
the criteria this way yourself if you wish. 
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PROBLEM CHARACTERS 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_12.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Criteria field for 
Department and type Sales 
& Marketing 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group – no records will 
appear 

 
Click on the top half of View 
to see how Access has 
converted your criteria 
because of the ampersand 

 
Replace the value in Criteria 
with “Sales & Marketing” 
as shown 

 
Click on the top half of View 
to now see 32 Sales & 
Marketing records 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on 
[Save As] 

 
Type Query – Problem 
Character Example in Save 
to, then click on [OK] 

 
Close the query 

 

There are certain problem characters that can 
cause errors in select queries. Generally, you 
should avoid brackets and ampersand (&) 
characters when working with fields as these are 

sometimes used to perform special operations. If 
you need to query using special characters, the 
whole criteria should be enclosed within quotation 
marks. 

2 The query is asking Access to display records that have only Sales and 
only Marketing in the Department field, rather than Sales & Marketing. 

For Your Reference… 

To query when special characters are involved: 

1. Open the query in Design View 

2. Click in Criteria for the relevant field 

3. Type the criteria, including the special 
character, enclosed within quotation marks 

4 

Handy to Know… 

 If you need to search for an accented word in 
a query, such as café, use the question mark 
(?) wildcard character in the place of the 
accented letter. 

5 

Quotation marks enclose the individual words Sales and Marketing… 

…when actually you want the whole phrase Sales & Marketing enclosed 
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QUERYING WITH A LOOKUP TABLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries can be created using more than one 
table as the source. This is particularly useful 
where lookup tables are involved. This is 
important in transactional tables where 

informational data is contained in the lookup table. 
Using queries, it is very easy to extract relevant 
data from both associated tables in a lookup 
configuration. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file Query 
Techniques_13.accdb… 

 
Click on the Create tab, then 
click on Query Design in the 
Queries group to display the 
Show Table dialog box  

 
Double-click on Expense 
Transactions, then on 
Employees to add both tables 
to the query, then click on 
[Close] 

 
Double-click on the ExpDate, 
Description and Amount fields 
in Expense Transactions to 
add them to the grid 

 
Double-click on the LastName, 
FirstName and Department 
fields in Employees to add 
them to the grid 

 
Ensure the Query Tools: 
Design tab is selected, then 
click on the top half of View in 
the Views group to run the 
query 

 
Click on the File tab and select 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – Lookup Table 
Example in Save to and click 
on [OK] 

 
Close the query 

 

1 

For Your Reference… 

To query with a lookup table: 

1. Click on the Create tab, then click on Query 
Design in the Queries group 

2. Choose the transaction and the lookup table 
in the Show Table dialog box 

3. Choose fields as normal 

2 

Handy to Know… 

 When querying with a lookup table, tables 
are automatically shown as linked (related) 
when they are added to the query because a 
formal lookup relationship was established 
when the tables were first built. If no link lines 
appear in the query, you can create them 
within the query yourself. 

5 
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SORTING QUERY DATA NUMERICALLY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sorting can be done in a query (and also a 
datasheet for that matter) on either alphabetical 
or numerical data. When you sort a numeric field, 
your data will be sorted either from highest to 

lowest (descending) or from lowest to highest 
(ascending). In our case study, for example, we 
can use this to find out the employees with the 
highest and lowest salaries. 

Try This Yourself: 

O
p

e
n

 

F
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Before starting this exercise 
you MUST open the file 
Query 
Techniques_14.accdb... 

 
Right-click on 
qryEmployees and select 
Design View 

 
Click in the Sort field for 
Salary to display the drop 
arrow 

 
Click on the drop arrow and 
select Ascending to sort the 
query by Salary, from lowest 
to highest 

 
On the Query Tools: Design 
tab, click on the top half of 
View in the Views group to 
see the sorted query 

 
Click on the top half of View, 
then click on the Sort drop 
arrow and select 
Descending 

 
Click on the top half of View 
to see the salaries sorted 
from highest to lowest 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on 
[Save As] 

 
Type Query – Sorting 
Numerically in Save to, then 
click on [OK] 

 
Close the query 

 

3 

4 

For Your Reference… 

To create a sorted query: 

1. Open the query in Design View  

2. Click in Sort for the field to sort by 

3. Click on the drop arrow and select either 

Ascending or Descending 

6 

Handy to Know… 

 You can easily sort a query table after it has 
been run by clicking on the field heading you 
wish to use for sorting. 
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DISPLAYING NULL VALUES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In Access, a field in a record that is left empty is 
said to contain a NULL value. Searching for 
fields with NULL values can be challenging. For 
example, if you leave the appropriate query cell 

in a grid empty you’ll get all records because there 
is nothing to match. To search for NULL records 
you must use the Is NULL expression which 
performs a test to see if the field is empty. 

Try This Yourself: 

O
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n

 

F
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Before starting this 
exercise you MUST open 
the file Query 
Techniques_15.accdb… 

 
Double-click on the table 
Employees to open it, 
then if necessary scroll 
across so you can see the 
Started field 

Notice that some of the 
Started fields are empty… 

 
Close the table, then 
right-click on 
qryEmployees and select 
Design View 

 
Click in the Criteria field 
for Started and type Is 
Null 

 
On the Query Tools: 
Design tab, click on the 
top half of View in the 
Views group to see all of 
the records that have an 
empty Started field 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – NULL 
Example in Save to, then 
click on [OK] 

 
Close the query 

 

1 

3 

4 

For Your Reference… 

To display empty fields using a query: 

1. Open a query in Design View 

2. Type Is Null in the relevant Criteria cell 

3. Run the query 

Handy to Know… 

 Do not press  to clear data from a field 

in a table. A space is a valid character and 
although you can’t see anything in the field, it 
is still deemed to contain an entry. 
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QUERYING FOR UNIQUENESS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With queries it is possible to see just one 
example of a record. Let’s say you have a 
database of customer contacts. It is possible in 
this database that there are multiple contact 

people for a particular company. If you only want to 
find the companies that you deal with (rather than 
all of their contact points), you can run a query for 
uniqueness on the company. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Query 
Techniques_16.accdb... 

 
Click on the Create tab, 
then click on Query Design 
in the Queries group 

 
Double-click on Employees 
in the Show Table dialog 
box, then click on [Close] 

 
Double-click on the 
Department field to place it 
in the query grid 

 
Run the query to see all of 
the records (100 of them), 
then return to Design View 

 
On the Query Tools: 
Design tab, click on 
Property Sheet in the 
Show/Hide group to display 
the Property Sheet pane, 
then click in a blank part of 
the query so Query 
Properties appears in the 
Property Sheet pane 

 
Click on No in Unique 
Values, then click on its 
drop arrow and click on Yes 

 
Click on Run 

Each Department will 
appear only once… 

 
Close the query without 
saving 

 

For Your Reference… 

To query for uniqueness: 

1. In query Design View, display the Property 
Sheet pane 

2. Change the Unique Values property to Yes 

3. Run the query 

Handy to Know… 

 When querying for uniqueness, don’t confuse 
Unique Values with Unique Records. In a 
table with a primary key every record is 
unique so marking the Unique Record 
property as unique will still give you all of the 
records. 

3 

5 

7 



Microsoft Access 2016 - Simple Queries 

© 2017 The University of Nottingham Page 30 Chapter 2 - Querying Techniques 

NOTES: 
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CHAPTER 3 MULTI-TABLE QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of how relational queries work 

 learn how to create a relational query design 

 learn how to filter a relational query 

 learn how to filter related fields and some of the 
associated problems 

 learn how to add more tables and fields to a query design 

 learn how to work with hidden fields in the query grid 

 gain an understanding of the three join types in Access 

 learn how to create an inner join query 

 learn how to create a left outer join 

 learn how to create a right outer join. 

The real benefits associated with relational databases and queries 
become clear when you need to create a query that draws on data 
from several tables. 

With single tables you can create filters that essentially filter out 
unwanted data and display only what you need to see. 

To draw data from several tables, however, you are better advised 
to create a query. Queries that span multiple tables actually use the 
underlying table join settings to extract data quickly and easily for 
either one-off informational queries or full scale report-destined 
queries. 

INFOCUS 
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UNDERSTANDING RELATIONAL QUERIES 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

  

A query is like a filter that you can place on your 
data so that you can see or work with only the 
information that is relevant. Queries are used to 
display data (Select query) or to change data 

(Update query). Relational queries involve one or 
more linked tables and are the ideal way to create 
reports comprising of data from several different 
tables. 

How Relational Queries Work 

All queries, including relational queries, are based on a Query Design. 

The upper part of the design is known as the Field List, where Access displays the table or tables 
used for the query. If more than one table is chosen and the chosen tables are related, relational links 
will show how the tables are connected. 

The lower part of the query design is known as the Query Grid, where Access displays the fields from 
the tables that need to be used in the query operation. You can choose all fields to display, or a subset 
of the fields, which is more common. The Query Grid is also used to enter examples of the data for 
the query to search for. This sample data is known as criteria. 

The Field List displays 
the related tables – 
note how the links 
provide information 
about the type of join. 

The Query Grid 
contains the settings 
that determine the data 
that will be presented. 

In the example above, fields from all of the tables have been pulled into the query grid. Because of the 
nature of the joins (one-to-many) the resultant query will use the data from the transaction table 
(Expense Transactions) and supplement it with information from the two lookup tables (Employees 
and Expense Type). 

The criteria above is asking Access to present us with all transactions on or after March 1, 2015, and 
for either meals or postage greater than or equal to $50. When run, the resultant query would appear 
as: 
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CREATING A RELATIONAL QUERY DESIGN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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F
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Before starting this 
exercise you MUST 
open the file Multi Table 
Queries_1.accdb… 

 
Click on the Create tab, 
then click on Query 
Design in the Queries 
group to display the 
Show Table dialog box 

 
Double-click on the 
tables: Employees, 
Expense Transactions 
and Expense Type, then 
click on [Close] 

 
Double-click on the 
fields, as listed, to 
populate the query grid 

 
Click on Save in the 
QAT to display the Save 
As dialog box 

 
Type Employee 
Expenses in Query 
Name, then click on 
[OK] 

The new query is listed 
in the Navigation pane… 

 
On the Query Tools: 
Design tab, click on Run 
to run the query 

 
Close the query 

 

 

Irrespective of whether you are creating a query 
for a single table or for multiple tables, the query 
is originally created from options on the Create 
tab on the ribbon. The key to multiple-table 

queries is selecting the tables to use when the 
Show Table dialog box appears. Here you can 
select which tables to pull into the Field List on the 
query design. 

1 

For Your Reference… 

To create a relational query: 

1. Click on the Create tab and click on Query 
Design in the Queries group 

2. Double-click on the tables to add 

3. Double-click on the fields to add to the query 
grid 

2 

Handy to Know… 

 It doesn’t matter in which order you place 
tables in the Field List in the query because 
how the data is presented when the query is 
run is determined by the relationship joins. 

3 Table: Field: 

Expense Transactions ExpDate 

Expense Type 

Amount 

Employee FirstName 

LastName 

Department 

PhoneNo 
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FILTERING A RELATIONAL QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a
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Continue using the previous 
file with this exercise, or 
open the file Multi Table 
Queries_2.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
Click in the Criteria cell for 
Amount and type >150 

 
On the Query Tools: 
Design tab, click on Run in 
the Results group to display 
all of the transactions greater 
than 150 

 
On the Home tab, click on 
the top half of View in the 
Views group to return to 
Design View, then delete 
the previous criteria and try 
each of the examples as 
shown (delete the previous 
criteria after each one) 

 
Close the query – click on 
[No] to close without saving 
the design changes 

 

A relational query is filtered in the same way as a 
single table query by providing examples of the 
data in the criteria cells displayed in the query 
grid. Text field examples need to be enclosed in 

quotation marks, but Access will do this for you. 
Numeric and date fields can make use of operators 
such as greater than, less than, equal to, and so 
on. 

2 

For Your Reference… 

To filter a relational query: 

1. Open the query in Design View 

2. Type a relevant example or expression in the 

Criteria cell of the appropriate fields 

3 

Handy to Know… 

 If you save a query as it is closed, the last 
criteria example used will be saved with the 
query. If you want to keep the Criteria cells 
clear, don’t save the query. 

Field: Criteria: 

Department Executive 

ExpDate >01/07/08 

ExpDate Between 01/06/08 And 30/06/08 

 

4 
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FILTERING RELATED FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The real strength of related queries is not only 
being able to choose fields from different tables 
for the query, but also to be able to filter them 
and provide them with criteria values. While this 

works well for most fields, there are a few problems 
when trying to filter on the lookup fields that have 
been used to create the relationship between the 
tables. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or open 
the file Multi Table 
Queries_2.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
Click in the Criteria cell for 
Expense Type and type 
Meals 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group 

An error message will appear 
indicating a data mismatch. 
This has occurred because 
Expense Type is actually a 
numeric field which looks up 
the Expense Type table using 
the ExpTypeNo field… 

 
Click on [OK] to close the 
message 

 
Select the value in Criteria for 
Expense Type and type 6 

This is the ExpTypeNo for 
Meals… 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group to display all of 
the transactions for Meals 

 
Close the query – click on [No] 
to discard the changes 

 

2 

3 

For Your Reference… 

To filter related fields: 

1. Type examples into the Criteria cell of any 
field in the query grid 

2. Take care to compensate for lookup fields 

6 

Handy to Know… 

 Using incorrect syntax when entering criteria 
can generate a data type mismatch error. For 
instance, if you place numerical or date 
criteria in quotation marks, rather than cross 
hatch symbols (#), Access interprets the data 
as text, rather than numbers. 
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ADDING MORE TABLES AND FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Query designs do not need to be static in design 
– you can add (or remove) tables and fields as 
dictated by your reporting needs. In our case 
study we have a Personal Details table that can 

be added to the design to provide us with extra 
fields for our employees, such as Salary. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Multi Table 
Queries_2.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
On the Query Tools: Design 
tab, click on Show Table in 
the Query Setup group to 
display the Show Table 
dialog box 

 
Double-click on Personal 
Details to add it to the 
design, then click on [Close] 

 
Double-click on Salary to 
add the field to the grid 

 
Click on Save in the QAT to 
save the changes 

 
Click in the Criteria cell for 
Salary and type >=85000 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group, to display 
expense transactions for 
employees with a salary 
greater than or equal to 
85,000 

 
Close the query – click on 
[No] to discard the criteria 
changes 

 

3 

6 

For Your Reference… 

To add more tables to a query design: 

1. Open the query in Design View 

2. On the Query Tools: Design tab, click on 
Show Table in the Query Setup group 

3. Double-click on the table(s) to add 

4. Click on [Close] 

7 

Handy to Know… 

 Save a query design after making a 
structural change to the design, and before 
you add criteria, to then be able to close the 
table later without the criteria but with the 
structural alteration. 



Microsoft Access 2016 - Simple Queries 

© 2017 The University of Nottingham Page 37 Chapter 3 - Multi Table Queries 

UTILISING HIDDEN FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Earlier we encountered a problem when we tried 
to enter text into a field that was numeric even 
though, because of its lookup arrangement, it 
displayed text results. The problem with our 

solution was that we have to enter the criteria as a 
numeric code. Utilising a hidden field, we can 
enter text values and have the correct result 
displayed without incurring a data mismatch error. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Multi Table 
Queries_3.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
In the query grid, click on 
the Show box for Expense 
Type so it appears without a 
tick – this will hide the field 
when the query is run 

 
In the Field List, double-
click on Description in the 
Expense Type table to add 
it to the end of the query grid 

 
Click on Save in the QAT to 
save these changes 

 
Click in the Criteria cell for 
Description and type Meals 

 
On the Query Tools: 
Design tab, click on Run in 
the Results group to display 
all of the Meals transactions 

 
Close the query – click on 
[No] to discard the changes 
since the last save 

 

2 

5 

For Your Reference… 

To hide a field from a query when it is run: 

 In the query grid, click on the Show box for 
the field so it appears without a tick 

Handy to Know… 

 Hiding a field from the query grid is better 
than removing it, as it still enables you to 
search the records based on that field. 

6 
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UNDERSTANDING QUERY JOINS 
 

 

 

 

 

 

In addition to selecting specific fields and 
specifying criteria for a query, the data that is 
displayed in a multi-table query is also influenced 
by the type of join that has been specified 

between the tables. Basically there are three types 
of joins at your disposal: an inner join, a left outer 
join and a right outer join. In Access these joins 
are numbered 1 to 3 respectively. 

A Classic Join Example 

The easiest way to understand the different joins is through the use of a simple example. Let’s 
assume you have two tables, one for Employees and the other for their expense transactions. The 
Employee table would have one record per employee, while the Expense Transactions table could 
have many transactions per employee. 

Join 1: An Inner Join 

This is the default join type in Microsoft Access 
and is the one most commonly used. In this type 
of join the query will display only employees who 
have transactions and the transactions recorded 
against them. Employees who do not have any 
transactions will not be shown, nor will 
transactions that are orphaned and do not have 
an associated employee (there really shouldn’t 
be any of these). 

Join 2: An Outer Left Join 

Let’s suppose you want to see all employees, 
irrespective of whether they do or don’t have 
transactions, as well as their transactions. An 
Outer Left Join achieves this. Again, orphaned 
transactions that do not have any associated 
employee will not appear. 

Join 3: An Outer Right Join 

Let’s suppose you want to see all of the 
transactions, both those that have associated 
employees and those that are orphaned, then 
use the Outer Right Join. This join focuses on 
the transaction side of the join showing all 
transactions, but only employees from the left 
side that have transactions. 

Join Properties 

When you right-click on a join between tables 
you can open the Join Properties dialog box. In 
this dialog box you can specify the type of join to 
work with. 
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CREATING AN INNER JOIN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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 Before starting this exercise you 

MUST open the file Multi Table 
Queries_4.accdb… 

 
Click on the Create tab, then 
click on Query Design in 
Queries 

 
Double-click on Employees and 
then on Expense Transactions, 
then click on [Close] 

 
Right-click on the line that joins 
both tables and select Join 
Properties to display the Join 
Properties dialog box 

 
Ensure option 1: is selected, 
then click on [OK] 

 
Double-click on the EmpNo, 
FirstName and LastName fields 
in the Employees table, and the 
asterisk (*) in the Expense 
Transactions table 

 
On the Query Tools: Design 
tab, click on Run in the Results 
group to run the query and note 
the records 

 
Click on the File tab, select 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type qryInnerJoin, then click 
on [OK] 

 
Close the query 

Inner Joins are the default join type and are 
automatically created for you when you have two 
joined tables in a query. Essentially an inner join 
shows only records from either table that are 

matched in the other table. Records in the left table 
that do not have matches in the right table won’t 
appear, nor will records in the right table that aren’t 
matched to records in the left table. 

2 

3 

For Your Reference… 

To create an inner join query: 

1. In query Design View, right-click on the join 
line, then select Join Properties 

2. Ensure option 1: is selected and click on 

[OK] 

Handy to Know… 

 With an inner join query, which is the default 
join type, only records from the left table that 
have matches in the right table are joined. 
Orphans from the right table are not shown 
when the query is run. 

6 
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CREATING A LEFT OUTER JOIN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With left outer joins the table on the left side of 
the join has precedence and all records of that 
table, irrespective of whether they have matching 
records in the right table, will appear. Records 

from the right table will only appear if they are 
matched to records in the left. With a left outer join 
it is the left table that is ‘dominant’. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or open 
the file Multi Table 
Queries_5.accdb... 

 
Open the query qryInnerJoin 
in Design View 

 
Click on the File tab, select 
Save As, click on Save 
Object As, then click on 
[Save As] 

 
Type qryLeftOuterJoin, then 
click on [OK] 

 
Right-click on the join line and 
select Join Properties 

 
Click on option 2:, then click 
on [OK] 

 
On the Query Design: Tools 
tab, click on Run in the 
Results group to run the 
query 

This time all employees, 
whether they have 
transactions or not, will be 
displayed… 

 
Save and close the query 

 

4 

5 

For Your Reference… 

To create a left outer join query: 

1. In query Design View, right-click on the join 
line, then select Join Properties 

2. Click on option 2: and click on [OK] 

Handy to Know… 

 Follow the arrow in a join between tables in a 
query to get an idea of what is happening. If 
an arrow points to the right table, then all of 
the records from the left will appear but only 
matching ones from the right will show up. 

6 
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CREATING A RIGHT OUTER JOIN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Multi Table 
Queries_6.accdb... 

 
Open the query qryInnerJoin 
in Design View 

 
Click on the File tab, select 
Save As, click on Save 
Object As, then click on 
[Save As] 

 
Type qryRightOuterJoin, 
then click on [OK] 

 
Right-click on the join line, 
then select Join Properties 

 
Click on option 3:, then click 
on [OK] 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group to run the 
query 

This time all transactions, 
whether they have associated 
employees or not, will be 
displayed… 

 
Save and close the query 

 

In a right outer join the table on the right, which 
is usually the transaction table, is the dominant 
table. In this type of join, all of the transactional 
records will appear irrespective of whether they 

are orphaned (don’t have a match on the left) or 
not. In a good database design there should never 
be unmatched transactions – so this type of query 
is ideal for tracking down data problems. 

4 

5 

For Your Reference… 

To create a right outer join: 

1. In query Design View, right-click on the join 
line, then select Join Properties 

2. Click on option 3: and click on [OK] 

Handy to Know… 

 Databases with sound rules of referential 
integrity should never present unmatched 
transactions. For example, in a good system 
you should not be able to delete an 
employee if there are still open transactions 
for that employee. 

6 
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NOTES: 
 

 

 



Microsoft Access 2016 - Simple Queries 

© 2017 The University of Nottingham Page 43 Chapter 4 - Creating and Using Reports 

CHAPTER 4 CREATING AND USING REPORTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of the reporting process in Access 

 learn how to create a basic report 

 learn how to work with reports and switch between the 
various views 

 learn how to preview and print a report 

 learn how to change the layout of a report 

 learn how to use the Report Wizard to create a report 

 learn how to use the Report Wizard to create a grouped 
report 

 learn how to use the Report Wizard to create a statistical 
report 

 learn how to work with grouped reports. 

Reports in Access provide a way of formally presenting data from 
either tables or queries. In essence, reports are used to present raw 
data in a format that is more readable, understandable and better to 
look at. 

INFOCUS 
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UNDERSTANDING REPORTING IN ACCESS 
 

 

 

 

 

 

Reports provide you with a means of more 
formally presenting, and even analysing, data 
from your tables and queries. Reports have 
traditionally been produced as printed documents 

but they can also be viewed on the screen or 
published to the web. Before creating a report, it is 
advisable to understand how they work and what 
they can actually do for you. 

Creating Reports 

All database systems, including Access, provide you with a report generator facility to design your 
reports. Reports themselves do not contain data, but are created as structural templates into which 
the data is placed when the report is run. The template basically defines what to display (e.g. which 
fields to use), where to display it (e.g. where the fields should appear on the page), and how it should 
look (e.g. font size, colour, etc). 

When a report is first created it is based on either an existing table or an existing query. You base the 
report on a table if you wish to report on all of the data, or a query if you wish to report on just a 
subset of the data. 

The Many Ways of Creating a Report 

In Access you can create simple reports or very complex and intricate reports. So, as you’d expect, 
Access offers several ways for you to create reports. In Access, reports are created from the tools on 
the Create tab on the ribbon. Here you can create: 

 A basic, no frills report using the Report tool – these reports appear almost instantly and 
require very little work on your part. All of the work is done for you. 

 More intricate reports using the Report Wizard tool – the Report Wizard metaphorically holds 
your hand and asks you a series of questions which ultimately, when answered, result in a 
report. 

 A complex, elaborate report using either the Blank Report tool or the Report Design tool – 
these options present you with a blank report canvas and you are required to do all of the work 
to lay out what you want, where you want it, and how it should look. This is the most difficult of 
the options to use as you have to do everything yourself. 

Achieving a Balance 

There is no right or wrong way to create reports – choose the method that achieves the results using 
the least amount of time and effort. 

The beauty of the reporting tools in Access is that even after you have created a report using any of 
the techniques, the report can still be edited, modified and customised to suit specifically what you are 
after. So even if the basic report doesn’t quite provide you with what you want or the Report Wizard 
hasn’t quite done all it should, you can still change the report design yourself. 

Many Access users create their reports using the Report tool or the Report Wizard tool, and then 
fine-tune the layout or the design to suit their needs. 
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CREATING A BASIC REPORT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The easiest and simplest way to create a basic 
report in Access is to use the Report tool which 
is located on the Create tab on the ribbon. All 
you need to do here is to select the table or the 

query in the Navigation pane as the basis for the 
report and then run the command. 

Try This Yourself: 

O
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 Before starting this exercise 

you MUST open the file 
Reports_1.accdb… 

 
In the Navigation pane, click 
on the Employees table to 
select it 

This indicates the table to 
base the report on… 

 
Click on the Create tab, then 
click on Report in the 
Reports group 

A report layout will instantly 
appear. The Layout View of 
the report allows you to make 
adjustments to the report 
template… 

 
On the Report Layout Tools: 
Design tab, click on View in 
the Views group to see the 
report in Report View where 
the data is presented 

Data is presented in Layout 
View as well, but Report View 
is the finished view of the 
report… 

 
Click on Save in the QAT to 
display the Save As dialog 
box 

 
Type rptEmployees in 
Report Name, then click on 
[OK] to save the design and 
layout 

 
Close the report 

 

2 

For Your Reference… 

To create a basic report: 

1. Click on the table or query in the Navigation 
pane 

2. Click on the Create tab, then click on Report 
in the Reports group 

3 

Handy to Know… 

 When creating reports, Layout view allows 
you to make changes to the layout of a 
report, such as column widths, row heights, 
field placement etc. Report view is the 
polished view of the report. 

5 
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WORKING WITH EXISTING REPORTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reports do not contain data – they are simply 
templates with field placeholders which 
determine where data will be placed. As a 
consequence there are several different views of 

a report – you can see its structure in both the 
Design and Layout views, and you can see data in 
Report, Print Preview and Layout views. 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
Reports_2.accdb... 

 
Double-click on the report 
rptEmployees to open it 

Report view shows you 
the report with data. No 
changes can be made to 
either the data or the 
report layout here… 

 
On the Home tab, click on 
View in the Views group 
to see the report in Layout 
view where changes can 
be made 

The View tool toggles 
between Layout and 
Report views… 

 
Click on the bottom half of 
View and select Design 
View 

Design view is the ultimate 
design and layout view 
where you can edit the 
fields, placements and 
even formats, and also 
make changes to report 
headers and footers… 

 
Close the report 

 

1 

For Your Reference… 

To change the report view: 

1. Open the report in any view 

2. On the Home tab, click on the bottom half of 
View in the Views group and select the 
desired view 

Handy to Know… 

 Changes to report structure are made in 
either Layout or Design view. Layout view 
provides a view of the report with data in 
place. Design view provides access to more 
of the detailed areas of the report such as 
the header and footer. 

3 
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PREVIEWING AND PRINTING A REPORT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Reports_2.accdb... 

 
Right-click on rptEmployees 
and select Print Preview to 
see the report in preview mode 

 
Click on Next Page and 
Previous Page at the bottom 
of the window several times to 
view the pages 

The report is too wide to fit on 
one piece of paper… 

 
On the Print Preview tab, click 
on Landscape in the Page 
Layout group to turn the report 
sideways 

We still haven’t got all columns 
on one page, but let’s print just 
the first page to see how it 
looks… 

 
Click on Print in the Print 
group to display the Print 
dialog box 

 
Click on Pages in Print Range 
and type 1 in both From and 
To 

 
Click on [OK] to print the first 
page of the report 

 
Close the report 

 

Reports are commonly designed for and printed 
on paper using a printer. While you can print a 
report without directly running it, it is a good idea 
to use Print Preview to see how it will look 

before it is sent to the printer. Often you will find 
that the report is too wide or needs to be changed 
in some other way prior to a formal print run. 

1 

5 

For Your Reference… 

To preview and print a report: 

1. Right-click on the report in the Navigation 
pane and select Print Preview to see the 
report in preview mode 

2. On the Print Preview tab, click on Print in 
the Print group to print the report 

Handy to Know… 

 Basic reports seldom print well without a bit 
of editing. Typically there may be too many 
columns or rows to fit neatly on a page. 
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CHANGING THE REPORT LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Layout view provided for reports in Access 
allows you to make adjustments to the layout of 
the report. These adjustments may be required 
for aesthetic purposes, to make the report more 

visually appealing, or for practical purposes such 
as trying to squeeze the report onto one page. In 
Layout view you can adjust column widths and 
instantly see whether they will work or not. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Reports_3.accdb... 

 
Right-click on rptEmployees 
and select Layout View 

 
Point to the right border of the 
orange square surrounding 
Emp No 101 

The pointer should change to a 
double-headed arrow… 

 
Hold down the left mouse 
button and drag the border left 
to make the column narrower 

 
Click in the FirstName column, 
then repeat steps 2 and 3 to 
make this column narrower 

 
On the Report Layout Tools: 
Design tab, click on the bottom 
half of View in the Views 
group, select Print Preview, 
then click on One Page in the 
Zoom group to see if the 
Comments fit on the page  

 
Click on Close Print Preview 
in the Close Preview group, 
then repeat steps 2 and 3 with 
the other columns, until the 
Comments column is on the 
page 

 
Save and close the report 

 

2 

3 

For Your Reference… 

To adjust column width in a report: 

1. Open the report in Layout view 

2. Click in the column to change 

3. Point to the right border of the orange 
square, hold down the left mouse button and 
drag left to narrow the column 

Handy to Know… 

 The grey dotted lines that appear in Layout 
view of a report indicate whether the page 
will break when printed. These dotted lines 
are based on the current printer settings on 
your computer and are very useful when 
trying to resize a page of the report. 

6 
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USING THE REPORT WIZARD 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Report Wizard will guide you through the 
process of creating more formal reports from the 
data in your data table. The Report Wizard 
consists of a number of screens that prompt you 

for the information required to generate a report. 
Some of the screens may seem cryptic to begin 
with, but you will soon learn what is required and 
be able to generate reports quickly and efficiently. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Reports_4.accdb... 

 
In the Navigation pane, click 
on the Employees table to 
specify the table to report on 

 
Click on the Create tab, then 
click on Report Wizard in the 
Reports group to start the 
Report Wizard 

 
Double-click on EmpNo, 
FirstName, LastName, 
Department and PhoneNo in 
Available Fields to add them 
to the Selected Fields list 

 
Click on [Next] to proceed to 
the next screen. Continue 
working through the screens 
using the settings as shown 

 
Once you have specified the 
title in the last screen of the 
wizard, click on Preview the 
report, then click on [Finish] 
to build the report 

Spend a moment previewing 
the report… 

 
Close the report 

The new report is now listed in 
the Navigation pane 

 

2 

3 

4 

For Your Reference… 

To create a report using the Report Wizard: 

1. Click on the table or query 

2. Click on the Create tab, then click on Report 
Wizard in the Reports group 

3. Complete the steps of the Wizard 

Screen Settings Click on… 

Grouping No change [Next] 

Sort Order 1. LastName, Ascending [Next] 

Layout Tabular & Portrait [Next] 

Title Employee Phone Listing  

 

Handy to Know… 

 When creating a report using the Report 
Wizard, if you have made a mistake in any of 
the screens or would simply like to review 
your work, click on [Back] to move back 
through previous screens. 

2 3 
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CREATING A GROUPED REPORT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By creating a grouped report you can present 
data so that it is grouped according to one or 
more fields. For example, if you create a grouped 
report listing all employees by department, the 

departments will be listed in alphabetical order and 
the employees will be listed in alphabetical order 
within each department. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Reports_5.accdb... 

 
In the Navigation pane, 
click on the Employees 
table 

 
Click on the Create tab, 
then click on Report 
Wizard in the Reports 
group to start the Wizard 

 
Double-click on 
Department, EmpNo, 
LastName, FirstName, 
Started and Salary, then 
click on [Next] 

In this screen you are 
required to specify how to 
group the records… 

 
Double-click on 
Department as the 
grouping level 

 
Click on [Next] and 
complete the remaining 
wizard screens as shown 

 
Click on [Finish] to build 
the report 

 
Close the report 

 

4 

5 Screen Settings Click on… 

Sort Order 1. LastName, Ascending [Next] 

Layout Stepped & Portrait [Next] 

Title Employee Salary Listing  

 

For Your Reference… 

To create a grouped report: 

1. Click on the Create tab, click on Report 
Wizard and create a report, selecting the 
field to be grouped on as the first field 

2. Select this field on the Grouping screen 

3. Complete the wizard and save the report 

6 

Handy to Know… 

 When creating a grouped report, you may 
find that you need to make minor 
adjustments to column widths in Layout 
View to be able to see all of the grouping 
column. 
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CREATING A STATISTICAL REPORT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

One great feature of reports is the ability to 
summarise the data in the database. For 
example, reports allow you to calculate the total 
(sum), minimum, maximum, average, and 

number of records (count) for numerical fields in a 
database. You can also count non-numerical fields. 
These statistical reports assist with analysis of 
the data in the database. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise, or open 
the file Reports_6.accdb... 

 
In the Navigation pane, click 
on the Employees table, click 
on the Create tab and click on 
Report Wizard in the Reports 
group 

 
Double-click on Department 
and Salary, then click on 
[Next] 

 
Double-click on Department 
as the Grouping level, then 
click on [Next] 

 
Click on [Summary Options] 
to display the Summary 
Options dialog box 

 
Click in the tick boxes for Sum, 
Avg, Min and Max, then click 
on Summary Only in Show 

 
Click on [OK] to return to the 
Wizard, then click on [Next] 
and complete the settings as 
shown 

 
Click on [Finish] to build the 
report 

We will fix the hash signs in 
the next exercise… 

 
Close the report 

 

4 

Screen Settings Click on… 

Layout Stepped & Portrait [Next] 

Title Salary Analysis Report  

 

6 

For Your Reference… 

To create a statistical summary report: 

1. Create a grouped report using the wizard 

2. Click on [Summary Options] on the sorting 
screen 

3. Click on the statistics required then click on 

[OK] and finish creating the report 

Handy to Know… 

 When a report displays hash signs (####) in 
lieu of numbers, it is because the column 
size in the report isn’t large enough to display 
the values in the fields. 

7 
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WORKING WITH GROUPED REPORTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

0  

If a column is not wide enough to display values, 
Access will substitute the values with cryptic 
signs like the hash (#) symbol. This can happen 
when using the statistical functions (sum, avg, 

etc.) on the values that involve many numbers, 
such as currency. To correct this problem you will 
need to access either Layout View or Design 
View and modify the column widths. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the 
previous file with this 
exercise, or open the file 
Reports_7.accdb... 

 
In the Navigation pane, 
double-click on Salary 
Analysis Report to run it 

Here you can see the hash 
signs replacing numbers… 

 
Switch to Design View 

 
In Department Footer, 
click on =Sum([Sal, hold 

down  and click on 
=Avg([Sal, =Min([Sal, 
=Max([Sal and =Sum([Sal 
(in Report Footer) 

You should have selected 
five fields… 

 
Point to the left border of 
one of the selected fields, 
click and drag to the left 
until the fields are about 3 
times as long 

 
Click on the Home tab, 
click on the bottom half of 
View in the Views group, 
then select Report View to 
run the report – this time 
the values are displayed 

 
Save and close the report 

 

3 

5 

For Your Reference… 

To modify the layout of a grouped report: 

1. Open the report in either Report Layout or 
Report Design view 

2. Make the changes to the layout as required 

Handy to Know… 

 You can adjust field widths either through 
Report Design view or in Report Layout 
view. However, =Sum (that sums the footer) 
is easier to access in Report Design view. 
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CONCLUDING REMARKS 

 

 

 

 

 

 

 

 

Congratulations!  

You have now completed Microsoft Access 2016 - Simple Queries. Microsoft Access 2016 - 
Simple Queries was designed to get you to the point where you can competently perform a variety 
of operations.  

We have tried to build up your skills and knowledge by having you work through specific tasks. 
The step by step approach will serve as a reference for you when you need to repeat a task. 

 

Where To From Here? 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills that you 
have acquired and use some of the application's commands. This will test just how much of 
the concepts and features have stuck! Don't try a big task just yet if you can avoid it - small 
is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points that you 
may be unclear about. Use the examples and exercises in these notes and have another go 
- these step-by-step notes were designed to help you in the classroom and in the work 
place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities browse the Internet, specifically the technical pages of 
the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we don't 
suggest that you plagiarise but you can certainly learn from the techniques of others 

 if your software came with a manual (which is rare nowadays) spend a bit of time each day 
reading a few pages. Then try the techniques out straight away - over a period of time 
you'll learn a lot this way 

 and of course, there are also more courses and books for you to work through. 

Hungry for More? 

We live in an ever-changing world where we all need to review and upgrade our 
skills. 

If you have received this course book on a training course why not ask the tutor or 
trainer for other courses that may be of benefit to you. If you are attending a 
college ask for one of their brochures. 

Alternatively, if you’ve enjoyed using this course book you can find others that 
cover a wide range of topics at our web site www.watsoniapublishing.com. 

 

http://www.watsoniapublishing.com/
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